Poglavije 2

Meniji i palete alatki Officea 2003

U ovom poglaviju
Koriséenje menija
Prikazivanje paleta alatki
Rad sa oknom poslova
Rad s viSe prozora

Upotreba Officeovog Clipboarda

D a bi se Microsoft Office Sto lakSe koristio, skoro svi programi iz ovog
paketa imaju slicne komande koje se zadaju miSem ili s tastature,
tako da se (teorijski) moZete prebacivati iz jednog programa u drugi bez
mnogo problema i nerviranja.

Naravno, sve dok ne naucite kako se zadaju komande u jednom programu
Officea 2003, necete moci da koristite nijedan program u paketu. Ovo
poglavlje vas uci uobicajenim nacinima upravljanja svim programima

u Officeu 2003 pomoc¢u miSa i tastature.

Upotreba menija

Linija menija se nalazi pri vrhu prozora svakog programa Officea 2003
i na njoj se nalazi nekoliko naslova menija, u kojima su razne komande
razvrstane po kategorijama. Nazivi menija koji su zajednicki u progra-
mima Officea 2003 jesu sledeci:

v File Sadrzi komande za otvaranje, snimanje i Stampanje datoteka.

v Edit Sadrzi komande za kopiranje, brisanje, umetanje, pretraZivanje
i menjanje podataka.

v View Sadrzi komande pomocu kojih se menja izgled podataka na
ekranu.

v Insert SadrZi komande za unos razlicitih vrsta podataka u datoteku,
poput linija, dijagrama ili hiperveza.
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v Format SadrZi komande za promenu izgleda podataka, kao §to su
fontovi ili razliciti nacini prikazivanja brojeva, na primer, datuma ili
naucnih notacija.

v Tools Sadrzi komande za rad s podacima u datoteci, poput pravo-

pisne provere. Tu se takode nalaze komande za podeSavanje izgleda
i rada Officea 2003.

v Window Sadrzi komande za rad s prozorima u odgovarajuc¢em pro-
gramu iz paketa Office 2003.

v Help SadrZi komande za dobijanje pomo¢i od Officeovog programa.

Koje se komande kriju ispod odredenog naziva menija saznacete ako
miSem pritisnete naziv menija, na primer File ili Help. Ukoliko pazljivo
pogledate, primeticete da je u svakom nazivu menija po jedno slovo
podvuceno. To je taster precCica koji mozete pritisnuti i tako pregledati
sadrZaj menija.

Primera radi, u naslovu menija File podvuceno je slovo F. To znaci da pri-
tiskom tastera Alt i potom tastera F moZete pregledati sadrzaj menija bez
upotrebe miSa.

Ako pritisnete samo taster Alt, Office 2003 ce istaci meni File. Sada mozZete
pomocu kursorskih tastera, strelicom ulevo/udesno, birati pojedinacne
naslove menija, a pritiskom strelice nadole ili tastera Enter pregledacete
sadrZaj obeleZenog menija.

Premestanje linije menija
Linija menija se podrazumevano nalazi pri vrhu prozora svakog programa
u paketu Office 2003. U slucaju da biste radije stavili liniju menija na neko
drugo mesto, uradite sledece:
1. Dovedite pokaziva€ miSa iznad rucice linije menija.
Kada pokaziva¢ misa dode ta¢no iznad rucice linije menija, poprimi
izgled Cetvorokrake strelice (slika 2-1). Na slici se vidi pozicija linije
menija u obliku plutajuceg prozora (na sredini ekrana) i (podrazu-
mevano) pri vrhu prozora programa.
2. Povucite miSem (pritisnite levi taster misa i povucite).
Dok povlacite miSem, linija menija je prikazana kao plutajuci prozor.
3. Otpustite levi taster miSa kada liniju menija postavite na Zeljeno
mesto.

Kada prevucete naslovnu traku menija do vrha prozora programa, linija
menija ¢e se vratiti na prvobitno mesto.
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Linija menija
Rudica Naslovna traka
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Prilagodavanje menija

Posto Office 2003 ima mnogo razli¢itih komandi, svaki meni pruza tri
nacina za njihovo prikazivanje:

v Stalno prikazuje sve komande. Na taj nacin vidite sve postojece
komande, ali vas ovaj prikaz moze i zbuniti zbog velikog izbora
opcija.

v Sakriva retko koriS¢ene komande. Ukoliko Zelite da prikaZete sve
komande odredenog menija, morate pritisnuti dugme Expand na
dnu menija.

v Sakriva retko koriSéene komande, ali ih nakon nekoliko sekundi
automatski prikazuje.

Da biste promenili ponasanje menija u svakom programu paketa Office
2003, uradite ovako:

1. Opredelite se za jednu od sledecih opcija:
¢ [zaberite Tools = Customize.
¢ [zaberite View = Toolbars = Customize.
Pojavice se okvir za dijalog Customize (slika 2-2).

2. Pritisnite karticu Options.
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3. Potvrdite ili uklonite znak za potvrdu ispred jednog od ovih polja:
¢ Always show full menus Ukoliko je ovo polje potvrdeno, pada-
ju¢i meniji prikazuju sve komande (slika 2-3).
¢ Show full menus after a short delay Ako je ovo polje potvrdeno,
retko koris¢ene komande prikazuju se nakon nekoliko sekundi.

4. Pritisnite Close.

Upotreba paleta alatki

Palete alatki sadrZze ikonice koje predstavljaju najcesce koriS¢ene
komande. Na taj naCin pruza vam se mogucénost da pritisnete ikonicu
na paleti kako biste izabrali komandu umesto da se provlacite kroz
menije ili pritiskate uvrnute kombinacije tastera, kao 5to je Ctrl+P. Dve
najCesce zastupljene palete alatki u svim programima Officea 2003 jesu
Standard i Formatting.

Standardna paleta alatki prikazuje ikonice koje predstavljaju univerzalne
komande menija File, Edit i Insert. Paleta alatki za formatiranje sadrzi iko-
nice koje predstavljaju komande menija Format.

Paletu alatki koristite tako Sto pritisnete ikonicu koja predstavlja odgo-
varajucu komandu. Ako ne znate Sta ikonice predstavljaju, zadrZite poka-
zivaC miSa iznad ikonice i saCekajte trenutak. Office 2003 ¢e prikazati
kratak opis komande (slika 2-4).
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Delimi¢no prosiren meni

Dugme za proSirivanje menija Potpuno proS$iren meni
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Slika 2-3:
Meniji mogu
stalno
prikazivati sve
komande.

Slika 2-4:
Kada zadrZite
pokaziva¢ misa
iznad ikonice
na paleti,
videcete koju
komandu ona
predstavlja.
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Slika 2-5:
Pritisnite
dugme Toolbar
Options da
biste prikazali

preostale |

ikonice.

Spajanje (ili razdvajanje) paleta Standard
i Formatting

Radi uStede prostora, Microsoft Office 2003 moZe da spoji palete Stan-
dard i Formatting u jedan red. NaZalost, takav prikaz ne sadrZi sve raspo-
loZive ikonice sa ove dve palete.

Kada su palete Standard i Formatting spojene, morate pritisnuti dugme
Toolbar Options da biste prikazali padajuc¢i meni s dodatnim ikonicama
koje nisu prikazane na paleti (slika 2-5).

Dugme Toolbar Options
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Ako hocete da postavite palete Standard i Formatting jednu iznad druge
kako biste videli sve raspoloZive komande, uradite sledece:
1. Izaberite jednu od navedenih komandi:
e Pritisnite Tools ©> Customize.
¢ Pritisnite View = Toolbars = Customize.
Pojavice se okvir za dijalog Customize.

2. Pritisnite jezicak kartice Options.

3. Potvrdite ili uklonite potvrdu ispred polja Show Standard and
Formatting Toolbars on two rows.
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]
Slika 2-6:

Kada su palete |
Standard |

i Formatting
razdvojene, na
ekranu se vide

sve raspoloZive
ikonice.

4. Pritisnite Close.

Office 2003 ce prikazati palete Standard i Formatting u dva reda
(slika 2-6).
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Skrivanje i prikazivanje paleta alathi

Pored standardne palete i palete za formatiranje, Office 2003 nudi veliki
broj dodatnih paleta s komandama koje ¢e vam moZzda zatrebati. Zbog
uStede prostora, te palete su obicno skrivene, ali ukoliko Cesto koristite
specificne komande, pruza vam se mogucnost da koristite paletu na
kojoj se nalaze komande koje obi¢no upotrebljavate.

Naravno, Sto je viSe paleta prikazano na ekranu, to ¢ete manje prostora
imati na raspolaganju da vidite Sta zapravo radite, pa zato Office 2003
uvek moze sakriti palete sa ekrana. Da biste sakrili ili prikazali paletu
alatki, uradite sledece:
1. Izaberite View > Toolbars.
Pojavice se padaju¢i meni Toolbars (slika 2-7). Ispred naziva paleta
koje su trenutno vidljive na ekranu nalaze se znaci za potvrdu.
2. Pritisnite naziv palete koju hocete da prikaZete (ili sakrijete).
Office 2003 poslusno prikazuje ili sakriva izabranu paletu.
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Slika 2-7:
Paletu alatki
cete sakriti ili
prikazati ako
pritisnete naziv
palete koju
prikazujete (ili
sakrivate).

Premestanje palete
Poput linije menija, palete alatki mogu se postaviti uz ivice ekrana ili, kao

plutajudi prozor, na sredinu ekrana. Paletu alatki premesticete na sledeci
nacin:

1. Dovedite pokaziva¢ misa iznad rucice palete alatki koju hocete da
premestite. (Ako se paleta nalazi usred ekrana, postavite pokazi-
va€ miSa iznad njene naslovne trake.)

Kada se pokazivac nade iznad rucice, poprimice oblik Cetvorostrane
strelice (slika 2-8). Ako pomerate paletu koja se nalazi usred ekrana,
videcete Cetvorostranu strelicu tek kada pritisnete levi taster misa.

2. Pritisnite levi taster misa i povucite miSem.
Paleta se pojavljuje u posebnom prozoru (slika 2-8).

3. Kada paletu postavite na odgovarajuce mesto, otpustite levi taster
misa.
Umesto da vam palete plutaju po ekranu, moZzete ih sabiti uz ivicu ili
dno ekrana.

NET
! Ako paletu ostavite da pluta nasred ekrana, moci cete da joj promenite

veli¢inu. Postavite pokaziva¢ miSa iznad ivice palete, pricekajte dok se
pokaziva¢ pretvori u dvosmernu strelicu, a zatim pomerajte misa drzeci
pritisnut levi taster.
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Rucica Naslovna traka
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Promena velicine palete

Ako su palete Standard i Formatting spojene u jednom redu, moZete
promeniti veliCinu jedne palete da biste prikazali viSe ikonica s druge
palete. Velicinu palete alatki promenicete ovako:

1. Dovedite pokaziva¢ miSa iznad rucice palete koja se nalazi u sre-
dini ekrana.
Kada se pokazivac nade iznad rucice, poprimice oblik Cetvorostrane
strelice (slika 2-8).

2. Pritisnite levi taster misa i povucite miSem.
Paleta ce se skupiti ili prosiriti, u zavisnosti od toga u kom ste
pravcu povukli miSem.

3. Kada paleta poprimi odgovarajucu veli¢inu, otpustite levi taster

misa.
SNITE
,S’b x Ako je paleta prikazana kao plutajuci prozor na sredini ekrana, uradite
z sledece:

1. Dovedite pokazivac¢ misa iznad ivice plutajuce palete.

Kada se pokazivac nade iznad rucice palete, poprimice oblik dvo-
smerne strelice.
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2. Pritisnite levi taster misa i povucite miSem.

Paleta ce se skupiti ili prosiriti, u zavisnosti od toga u kom ste

pravcu povukli miSem.

3. Kada paleta poprimi odgovarajucu veli¢inu, otpustite levi taster

misa.

Prikazivanje ili sakrivanje ikonica

Ako vam se €ini da su palete Standard i Formatting pretrpane, mozZete

sakriti ikonice koje retko upotrebljavate. Tako ¢e palete alatki sadrzati
samo ikonice koje predstavljaju najceSce koris¢ene komande. Sledi opis

postupka sakrivanja ili prikazivanja ikonica na paleti.
1. Pritisnite dugme Toolbar Options na paleti Standard ili paleti

]
Slika 2-9:
Pritisnite

dugme Toolbar
Options da
biste podesili
paletu alatki.

Formatting.

Pojavice se padajuci meni sa ikonicama koje se mogu postaviti na

izabranu paletu (slika 2-9).

Dugme Toolbar Options
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2. Izaberite opciju Add or Remove Buttons.
Pojavice se meni prikazan na slici 2-10.
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Slika 2-10: |

Znak za potvrdu
nalazi se pored
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ikonice koja je | _

trenutno
prikazana na
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3. Izaberite opcije Standard i Formatting.

4. Pritisnite levo od ikonice koju hocete da prikaZete na paleti.
(Uklonite znak za potvrdu pored ikonica koje hocete da sakrijete.)

Office 2003 odmah prikazuje ili sakriva izabrane ikonice.

5. Pritisnite bilo gde na ekranu da biste uklonili menije.

Okno poslova

Ponekad, kada izaberete komandu, na primer New u meniju File, Micro-
soft Office 2003 zahteva dodatne informacije da bi mogao da nastavi rad.
U slucaju komande New, Office 2003 nema predstavu da li hocete da
otvorite nov, prazan dokument ili nov dokument zasnovan na Sablonu.

Office 2003 ce prikazati dodatne opcije, od kojih treba da se opredelite za
jednu, u vidu veze u prozoru koji se zove okno poslova (engl. task pane).
Ono je smeSteno na desnoj strani ekrana (slika 2-11).

Svaki program u Officeu 2003 sadrzi razliita okna poslova. Na svakom se
nalaze opcije za obavljanje odredene vrste posla, poput izrade novog
slajda (u PowerPointu), pravljenja cirkularnog pisma (u Wordu) ili prika-
zivanja pomoci za odgovarajuci program (u celom paketu Office 2003).
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Slika 2-11:
Okno poslova
prikazuje razne
opcije, dok
istovremeno

omogucava da
vidite sadrzaj
dokumenta

na ekranu.

Upotreba okna poslova

Kada izaberete komandu, okno poslova se pojavi na ekranu i prikazuje
sve raspoloZive opcije. Kada se opredelite za opciju, pritisnite vezu istak-
nutu plavom bojom.

pNET . .
© Veze u oknu poslova prepoznacete ako miSem predete preko teksta.

Kada tekst postane podvucen i pokaziva¢ misa poprimi izgled Sake,
znacete da se mi$ nalazi iznad veze.

Posto izaberete opciju iz okna poslova, Office 2003 uklanja okno sa
ekrana tako da mozZete nastaviti rad.

Skrivanje i prikazivanje okna poslova

Ako Zelite da prikaZete okno poslova na ekranu, a da ne zavisite od
zadavanja komande koja ¢e tokom vaSeg rada otvoriti okno poslova,
izaberite jednu od ovih komandi:

v lzaberite View = Task pane
v Pritisnite Ctrl+F1

Okno poslova uklonicete sa ekrana kada pritisnete dugme za zatvaranje
u gornjem desnom uglu okna poslova.
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Poglavlje 2: Meniji i palete alatki Officea 2003

Slika 2-12:
Okno poslova
omogucava
izbor dodatnih
opcija tokom
rada u
programu
Officea 2003.

Kretanje po oknu poslova

Okno poslova prikazuje razli¢ite vrste informacija u raznim situacijama,
Sto znaci da je vrlo verovatno da okno poslova nece prikazati pravu
informaciju u odredenom trenutku. Sre¢om, moZete promeniti vrstu
informacija u oknu poslova koristec¢i ponudenu listu ili dugmad Back,
Forward ili Home (slika 2-12).

Dugme Forward

Dugme Back Dugme Home
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Dugme Home prikazuje poCetnu stranu okna poslova, pomocu koje
moZete napraviti nov dokument ili otvoriti postojeci. Kada pritisnete
vezu u oknu poslova, prikazace se druge opcije.

Pritiskom dugmeta Back pojavice se opcije koje su prethodno bile prika-
zane u oknu poslova. Ako posle pritiska ovog dugmeta poZelite da se vra-
tite na prikaz koji je prethodio tekuc¢em, pritisnite dugme Forward.

Kada otvorite padajucu listu Task Pane, videcete sve ostale informacije
koje okno poslova moZe da prikaZe, poput okna poslova sistema pomoci
ili Clipboarda (slika 2-13).
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Slika 2-13:

U padajuéoj
listi Task Pane
nabrojane su
sve vrste
informacija
koje se mogu

prikazati u oknu |

poslova.

Padajuca lista Task Pane
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Rad sa vise prozora istovremeno

[zuzev Outlooka i Accessa, u svakom programu Officea 2003 moZete otvo-
riti viSe datoteka. Primera radi, u jednom prozoru Worda moZete prika-
zati radnu biografiju, a u drugom tekst o davanju otkaza. Otvaranjem vise
datoteka u zasebnim prozorima, moZete raditi s nekoliko dokumenata
istovremeno i kopirati podatke iz jedne datoteke u drugu.

Prelazak iz jednog prozora u drugi

Kad god otvorite nekoliko prozora, samo jedan moZe biti aktivan u datom
trenutku. Da biste se prebacivali iz jednog prozora u drugi, izaberite
jednu od sledecih opcija:

v Pritisnite miSem unutar prozora u koji se prebacujete (pod uslovom
da moZete da ga vidite).

v Otvorite meni Window i izaberite ime prozora u koji hocete da
predete.

v lzaberite ime prozora koje je prikazano na Windowsovoj paleti
poslova na dnu ekrana (ili tamo gde ste je sami premestili).
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Poglavlje 2: Meniji i palete alatki Officea 2003

Rasporedivanje prozora na ekranu

Ako otvorite dva ili viSe prozora, njihove sadrzaje moZete istovremeno
videti na ekranu. To vam omogucava da pregledate sadrzaj jednog pro-
zora dok uredujete sadrZaj drugog. Da biste na ekranu prikazali vi§e pro-
zora, sledite ovaj postupak:

1. Izaberite opciju Window => Arrange All.

Svi trenutno otvoreni dokumenti se sami rasporeduju po ekranu,
jedan iznad drugog.

Ako izaberete opciju menija Windows => Cascade, svi otvoreni pro-
zori Ce se prikazati na ekranu, sloZeni kao kartice u kartoteci.
2. Pritisnite prozor u kome hodete da radite.

Aktivni prozor (onaj Cijim se sadrZajem bavite) istiCe svoju naslovnu
traku, dok su naslovne trake ostalih prozora prigusene boje.

c)@ﬂ:‘\'

Prozore moZete da pomerate ili da im promenite veli¢inu tako Sto cete
pomeriti naslovnu traku prozora na drugo mesto na ekranu. Na taj nacin
moZete razmestiti prozore kako god vam odgovara.

Snimanje datoteka i zatvaranje prozora
pri radu s vise prozora

Posle izvesnog vremena ¢e vam mozda zasmetati svi ti otvoreni prozori
koji su pretrpali ekran. Prozor moZete zatvoriti izborom jedne od nave-
denih opcija:

v Pritisnite dugme za zatvaranje svih prozora koje hocete da zatvo-
rite. (To je dugme sa znakom X u gornjem desnom uglu prozora.)

v Pritisnite dugme za minimiziranje svih prozora koje Zelite da zadr-
Zite otvorene ako privremeno hocete da ih sklonite sa ekrana. (To je
dugme s horizontalnom crtom.)

Ako pritisnete dugme za zatvaranje na vrhu prozora programa, zatvori-
Cete i sam program.

Ukoliko je otvoreno dva ili viSe prozora, njihov sadrzaj mozete mnogo
QNVITE jednostavnije snimiti i zatvoriti ih pomocu komande Close All.

5 ﬂ Komanda Close All nije dostupna u programima Access i Outlook.
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34 Deo I: Upoznavanje s paketom Microsoft Office

Da biste zatvorili sve trenutno otvorene prozore, pridrZavajte se ovog
postupka:

1. DrZite pritisnut taster Shift.

2. Izaberite opciju menija File => Close All.
Dok drzite pritisnut taster Shift, meni File menja komandu Close u
Close All. Ako prethodno niste snimili neku datoteku, Office 2003 ce
prikazati okvir za dijalog u kome pita Zelite li da snimite podatke pre
nego §to zatvorite datoteku.

Kopiranje i prenosenje pomocu Officeovog
Clipboarda

Kada u Officeu 2003 kopirate objekat (tekst ili slike), racunar ga ¢uva na
Windowsovom Clipboardu, delu memorije u kome se privremeno ¢uvaju
objekti koje kasnije moZete koristiti. NaZzalost, Windowsov Clipboard
moze da sadrzi samo jedan objekat. Kada kopirate drugi objekat, Clip-
board ce obrisati prethodni da bi napravio mesta za novi.

Da bi izbegao ovaj problem, Microsoft Office 2003 ima svoj, specijalan
Office Clipboard. On radi na isti na¢in kao i Windowsov Clipboard, osim
§to mozZe istovremeno da ¢uva do 24 (dvadeset Cetiri, prebrojte ih ako ne
verujete) objekta.

Najvece ogranicenje Officeovog Clipboarda jeste to Sto ga moZzete kori-
stiti samo dok radite s programima Officea 2003. To je Microsoftov lukavi
pokusaj da konkurentske programe predstavi kao zastarele.

Sve §to isecete ili kopirate u programima Officea 2003, snima se i u Office-
ovom i u Windowsovom Clipboardu. Ako predete u program koji ne pri-
pada Officeu, poslednji iseCeni ili kopirani objekat u Officeu moZete da
prenesete u taj program. Razlika je, dakle, u tome Sto taj objekat briSe
prethodni sadrZzaj Windowsovog Clipboarda, dok se samo dodaje posto-
jecem sadrZaju Officeovog Clipboarda.

Kopiranje objekata na Officeov Clipboard
Da biste kopirali objekat (tekst ili sliku) na Officeov Clipboard, ili da biste
ga isekli iz dokumenta, uradite sledece:
1. Istaknite tekst ili graficki objekat koji hocete da kopirate ili isecCete.
2. Izaberite jednu od navedenih opcija:
¢ Izaberite Edit => Copy (ili Cut).

¢ Pritisnite Ctrl+C da biste kopirali objekat (ili Ctrl+X da biste ga
isekli).

e Pritisnite ikonicu Copy ili Cut na standardnoj paleti alatki.
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QMITE
S Sve §to isecCete ili kopirate, Office 2003 prenosi na svoj Clipboard. Posto

ﬂ iseCete ili kopirate 24 objekta, Office prilikom novog isecanja ili kopiranja
briSe s Clipboarda najstariji postojeci objekat.

NE%

gNJE!
> Kada iskljucite racunar, Officeov Clipboard ,,zaboravlja“ (brise) sve

objekte koji su u njemu bili snimljeni.

Urg 2%,

Prenosenje objekata sa Officeovog
Clipboarda

Posto ste kopirali ili isekli objekat u Officeovom programu, prenecete ga
sa Officeovog Clipboarda na sledeci nacin:
1. Pritisnite miSem mesto na koje Zelite da premestite objekat sa Offi-
ceovog Clipboarda.
2. Izaberite opciju menija Edit -> Office Clipboard.
Pojavice se okno poslova i prikazace Clipboard (slika 2-14).

't . Echlﬂl

e o s T v

] vem o 1 DR TR
T by (b

] i

|
Slika 2-14:
Officeov
Clipboard
prikazuje sve
objekte koje ste
isekli ili kopirali

u nekom Eu-""_=' e
programu i i —r
Officea 2003. | .. =)

3. Dovedite pokazivac miSa iznad objekta koji prenosite sa Office-

ovog Clipboarda.
[zabrani objekat se istice i prikazuje strelicu nadole na svom

desnom Kkraju.
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4. Pritisnite strelicu nadole.
Prikazace se padajuci meni.

5. Izaberite opciju Paste. (Da biste premestili sve objekte koji se
nalaze na Officeovom Clipboardu, pritisnite dugme Paste All.)

Ako pritisnete kombinaciju tastera Ctrl+V, izaberete opciju menija Edit &
Paste ili pritisnete ikonicu Paste na standardnoj paleti alatki, prenecete
objekat koji ste poslednji kopirali ili isekli u nekom Officeovom programu.

Ciscenje Officeovog Clipboarda
Posto Office 2003 sve iseCene ili kopirane objekte uva na Officeovom
Clipboardu, treba da znate kako da uklonite nepotrebne objekte sa njega,
da biste oslobodili mesto za nove. (Ako to ne budete sami radili, Office
2003 ce, kada broj objekata na Clipboardu dode do 24, automatski brisati
najstariji objekat prilikom svakog novog isecanja ili kopiranja.) Da biste
obrisali objekat s Clipboarda, uradite sledece:
1. Izaberite opciju menija Edit => Office Clipboard.
Prikazace se Officeov Clipboard sa svim objektima koje trenutno
sadrzi (pogledajte sliku 2-14).
2. Postavite pokaziva¢ miSa iznad objekta koji hocete da uklonite
sa Officeovog Clipboarda.
[zabrani objekat se istiCe i prikazuje strelicu nadole na svom desnom
kraju.
3. Pritisnite strelicu nadole.
Prikazace se padajuci meni.
4. Izaberite Delete.
Office 2003 briSe izabrani objekat sa Clipboarda.

Da biste uklonili sve objekte koji se nalaze na Officeovom Clipboardu,
pritisnite dugme Clear All.
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